
 Flarium24 Welcome

Welcome to Flarium24, An Interactve Fractal Generation Program.



File menu commands

The File menu offers the following commands:

Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Save 
Parameters As

Saves the parameters for the current image

Load 
Parameters

Loads the parameters from a parameter file, then draws the image.

Save Colors 
As

Save the color    parameters of the current image.

Load Colors Loads color parameters from a color (clr) file, then re-draws the image with the new 
colors..

Exit Exits the program

Draw menu commands

The Draw menu offers the following commands:

Newton Variations 1  Category 1 of Newton variation formulae.
Newton Variations 2 Category 2 of Newton variation formulae.
Sharon Webb Several formulae contributed by Sharon Webb.
Polynomials 1 Category 1 of several polynomial formulae.
Polynomials 2 Category 2 of several polynomial formulae.
Derbyshire / Newton Several of Paul Derbyshire’s Nova formulae and some Nova variations, Also the classic 

generalized Newton formula.
Phoenix Phoenix formula discovered by Shigehiro Ushiki.
Geometric Various non-fractal formulae.
Quaternions 2D slices of the formula “q=q^2+c” using Sir William Rowan Hamilton’s quaternion mathematics.
M-Set Method Mandelbrot escape time method for drawing fractals.
F-Set Combination of the Mandelbrot and Newton methods for drawing fractal images.

NOTE: The default method for generating fractals in the Flarium24 program is the Newton 
method.

Biomorph Different methods for testing combinations of x, and/ or y for escape time fractals. Originated by 
Cliff Pickover.

Inside-Out Draws the inverse fractal of the selected formula.    The inital value of z and c are 1/z and 1/c.
Orientation The Orientation option will rotate a fractal by changing the initial value of "c"
Zero-Init Forces the initial value of z to be zero, normally the initial value of z is set to c (as in z=c). Applies

to most formulae.
Abort Highlited when an image is being drawn, this option will terminate the drawing process.
Unique Editor Dialog Brings up the Unique Formula Editor dialog.
140.) Unique Formula Draws the image from the Unique Formula Editor dialog.



Unique Formula Dialog

The Unique Formula Editor gives the user the option to enter his/her own formulae.
The formula can be entered into the dialog edit field and then the image drawn by selecting OK. The formula can be 
saved as a Flarium24 parameter file (*.flu). The filters, color methods, Julia set, M-Set method, inverse operations, 
zooming, zero-init flag, etc. all work with the unique formula just as if it were another formula in the Flarium24 
program.    The unique formula number for formulae created with the formula editor is 140.

The formula parser was written by Gerry Myers. He can possibly be reached at myersge@hiwaay.net. if you have 
any comments or questions.

Currently, the Formula Parser has a problem with “Precedence”. The problem is that if a plus sign comes before a 
multiplication sign in an operation sequence, then the plus will be operated on first.    Normally, multiplication and 
division have highest precedence, then addition and subtraction. The exponent operand ^ should have lowest 
precedence.    Currently to work around the problem, just make sure that you use the parenthesis brackets (()) 
wherever possible.    The parser currently operates from left to right on an operation within the parentheses, and does
not take into account the precedence.

The formula parser is currently limited to 1024 characters.    There are three complex variables that can be used in a 
formula as constants.    They are u, v, and w.    The parser automatically looks for the value of “z” to be the complex 
number to be iterated and the value of “c” is used to represent the current pixel coordinate, similar to most all of the 
other formulae in the Flarium24 program.

The operators that the formula parser are capable of are as follows:

· + Plus
· - Minus
· * Multiplication
· / Division
· ^ Exponent (To the power of)
The complex trigonometric functions that the parser supports are sin, sinh, asin, cos, cosh, acos, and tan, atan, and 
log.

Some valid expressions are as follows:

· z*z+c

· This expression has a problem with the precedence.
· c+z*z

· sin(z*c)+c

· This formula creates a Kaleidoscope of 5 Mandeloids. Set the Zero-Init flag.
· (z*z)+(log(c^5)/5)    

· Also set the Zero-Init flag for this one.
· (z*z)+(log(c^2)/sin(c))-c    

· This is a third order Newton formula. Make sure color steps are set to at least 8,8,8.
· Also make sure the Zero-init flag is NOT set.
· z-((z*z*z-1)/(3*z*z))



Attractors menu commands

The Attractor menu offers the following commands:

Draw Draws the selected strange attractor.
Background Color Sets the background color for the strange attractor.
Latoocarfian dialog Brings up the dialog box for the Latoocarfian formulae.
Latoocarfian Pop-up menu to the Latoocarfian formualae
Affine Transformation 
Dialog

Brings up the dialog box for the 2D and 3D attractors.

2D Attractors Pop-up menu to the 2D attractor formulae.
3D Attractors Pop-up menu to the 3D attractor formulae.
XYZ Plane Pop-up menu to allow selection of a 2D plane to view the 3D attractor.



Latoocarfian
120.) Latoocarfian
  mxx = sin(my*mb) + mc*sin(mx*mb);
  myy = sin(mx*ma) + md*sin(my*ma);

121.)Latoocarfian Mutatation Alpha
mxx = sin(my*mb) + sin(mx*mb)*sin(mx*mb) 

+ sin(mx*mb)*sin(mx*mb)*sin(mx*mb);

myy = sin(mx*ma) + sin(my*ma)*sin(my*ma) 
+ sin(my*mc)*sin(my*mc)*sin(my*mc);



2D Attractors
122.) Chaotic Iterated Map
xnew = af[1] + x * (af[2] + af[3] * x + af[4] * y) + y 

  *(af[5] + af[6] * y);

  y = af[7] + x * (af[8] + af[9] * x + af[10] * y) + y 
  * (af[11] + af[12] * y);

  x = xnew;

123.) Iterated Function System
NOTE: The value of “j” is always a random number,

  xnew = af[1 + j] * x + af[2 + j] * y + af[5 + j];

  y = af[3 + j] * x + af[4 + j] * y + af[6 + j];

  x = xnew;



3D Attractors
124.) 
xnew = .0001 + af[1]*X  + af[4]*Y + af[7]*Z + X*Y*Z;
ynew = .0001 + af[2]*X  + af[5]*Y + af[8]*Z + X*Y*Z;
Z    = .0001 + af[3]*X  + af[6]*Y + af[9]*Z + X*Y*Z;
X = xnew;
Y = ynew;

126.) Quadratic by Julian C. Sprott
xnew = af[1] + af[2]*X + af[3]*X*X + af[4]*X*Y + af[5]*X*Z + af[6]*Y + 
af[7]*Y*Y + af[8]*Y*Z + af[9]*Z + af[10]*Z*Z;

ynew = af[11] + af[12]*X + af[13]*X*X + af[14]*X*Y + af[15]*X*Z + af[16]*Y + 
af[17]*Y*Y + af[18]*Y*Z + af[19]*Z + af[20]*Z*Z;

Z = af[21] + af[22]*X + af[23]*X*X + af[24]*X*Y + af[25]*X*Z + af[26]*Y + 
af[27]*Y*Y + af[28]*Y*Z + af[29]*Z + af[30]*Z*Z;

X = xnew;
Y = ynew;

127.) 
xnew = .001 + af[1]*X + af[2]*Y + af[3]*Z + 

af[4]*(X*X+Y*Y+Z*Z);  // 127
ynew = .001 + af[5]*X + af[6]*Y + af[7]*Z +

 af[8]*(X*X+Y*Y+Z*Z);
Z    = .001 + af[9]*X + af[10]*Y + af[11]*Z + 

af[12]*(X*X+Y*Y+Z*Z);
X = xnew;
Y = ynew;

128.)
xnew = af[1] + af[2]*X*Y + af[3]*Y*Z + 

af[4]*Z*X;  // 128
ynew = af[5] + af[6]*X*Y + af[7]*Y*Z + 

af[8]*Z*X;
Z = af[9] + af[10]*X*Y + af[11]*Y*Z + af[12]*Z*X;
X = xnew;
Y = ynew;

129.)
xnew = .001 + sin(af[1]*X) + af[2]*sin(af[3]*Y)

+ af[4]*sin(af[5]*Z);
ynew = .001 + sin(af[6]*X) + af[7]*sin(af[8]*Y

+ af[9]*sin(af[10]*Z);
Z    = .001 + sin(af[11]*X) + af[12]*sin(af[13]*Y) + 

af[14]*sin(af[15]*Z);
X  = xnew;
Y  = ynew;

130.)



xnew = .001 + af[1]*X*X  + af[2]*Y + af[3]*X + af[4]*Z;
ynew = .001 + af[5]*Y*Y + af[6]*Y + af[7]*X + af[8]*Z;
Z    = .001 + af[9]*Z*Z + af[10]*Y + af[11]*X + af[12]*Z;
X = xnew;
Y = ynew;

131.) Lorenz
lx = 0.6; ly=0.6; lz=0.6;

lx_save = lx;
ly_save = ly;
lz_save = lz;
            
// lorenz variables
lx=0.6, ly=0.6, lz=0.6;
lh=0.01;
frac = 8.0/3.0;

for (ri=0; ri<latoof_count; ri++)
{
  X = lxx = lx + lh*10*(ly-lx);
  Y = lyy = ly + lh*((-lx*lz) + 28*lx-ly);
  Z = lzz = lz + lh*(lx*ly - frac*lz);

  lx = lxx; ly=lyy; lz=lzz;
            
  PlotDotAt_3D();
}



Filter-1 menu commands

The Filter-1 menu offers the following commands:

0.) None
1.) if (fabs(dzx) < z.squares() || fabs(dzy) < z.squares())    rr+=nFF;
2.) rr += atan(fabs(dzy/dzx))*atan(fabs(dzx/dzy))*2;
3.) if (dzx < c.real()+dStrands && dzx > c.real()-dStrands) dzx_save += z.squares();
4.) if (dzx < c.real()+dStrands && dzx > c.real()-dStrands) dzx_save += fabs(atan(dzx/dzy))*3;
5.) if (fabs(dzx) < dStrands || fabs(dzy) < dStrands) dzx_save += (atan(fabs(dzx/dzy)))*3;
6.) if (dzx < c.real()+dStrands && dzx > c.real()-dStrands) rr += (fabs(dzx) + fabs(dzy));
7.) i+=(int)(sin(fabs(dzx_save)*fabs(dzy_save))*10);
8.) i+=(int)(sin(fabs(dzx_save)/fabs(dzy_save))*10);
9.) i += (int)(1/fabs(sin(dzx_save / dzy_save)));
10.) i += (int)(1/fabs(atan(dzx_save / dzy_save)));
11.) i += (int)(1/fabs(dzx_save * dzy_save));
12.) i = i * (int)((atan(fabs(dzx*dzx/dzy*dzy)))*10*nBay100);
13.) i=(int)((fabs(atan(z.real()/z.imag()))+fabs(atan(dzx_save/dzy_save)))*100);
15.) Standard Deviation
16.) Delta Slope, On Change;, ...J+=FF; plus atan method
17.) Delta Slope, On Change;, ...J+=FF;
18.) Delta Slope, No Change;, ...J+=FF;



Filter-2 menu commands

The Filter-2 menu offers the following commands:

30.)  (atan(fabs(x_rmax * x_rmin)/fabs(y_rmax * y_rmin)) * 40);
31.) if (fabs(dzx) <= dStrands || fabs(dzy) <= dStrands) rr=ri;
32.) if (dzx*dzx+dzy*dzy < limit) rr+=3;
33.) Combination Filters 1,2, && 3
34.) if (fabs(dzx) > dStrands || fabs(dzy) > dStrands)
35.) if (fabs(dzx) > dStrands &&&& fabs(dzy) > dStrands)
36.) if (fabs(dzx) > limit || fabs(dzy) > limit)
37.) if (fabs(dzx) < limit || fabs(dzy) < limit)
38.) if (fabs(1/dzx*dzy) > limit)
39.) if (fabs(dzx) > limit || fabs(dzy) > limit)
40.) ri = rr + atan(fabs(dzx_save/dzy_save)) * 30;
41.) rr+=log(dzx*dzx+dzy*dzy)*nBay100;
42.) ri = rr + atan(fabs(dzx_save/dzy_save)) * 50;
43.) ri = rr/3 + atan(fabs(dzx_save/dzy_save)) * 30;
44.) Combination atan and strands.
45.) Another atan and strands combination
46.) i = (int)rr; rr+=log(dzx*dzx+dzy*dzy)*(1+nBay100);
47.) i = (int)(rr + atan(fabs(dzx_save/dzy_save)) * (10+nBay1000));
48.) if (fabs(dzx) < z.squares() || fabs(dzy) < z.squares())    rr+=nFF;
49.) rr += atan(fabs(dzy/dzx))*atan(fabs(dzx/dzy))*2;
50.) if (dzx < c.real()+dStrands && dzx > c.real()-dStrands) dzx_save += z.squares();
51.) if (dzx < c.real()+dStrands && dzx > c.real()-dStrands) dzx_save += fabs(atan(dzx/dzy))*3;
52.) if (fabs(dzx) < dStrands || fabs(dzy) < dStrands) dzx_save += (atan(fabs(dzx/dzy)))*3;
53.) 6.) if (dzx < c.real()+dStrands && dzx > c.real()-dStrands) rr += (fabs(dzx) + fabs(dzy));



Filter-3 menu commands

The Filter-3 menu offers the following commands:

Nothing but strands. This option affects the following strands filters
54.) fabs(z) < dStrands || fabs(z) < dStrands
71.) fabs(z) < dStrands || fabs(z) < dStrands (Part II)
55.) Hi Lo Strands
56.) fabs(z) < fabs(c)+dStrands
57.) i = (int) (fabs(c.squares() - z.squares())*20000*nBay100);
58.) rr = fabs((z2.squares() - z.squares())*1000*nBay100);
59.) i += (int) (fabs(c.squares() - z.squares() + z2.squares())*1000*nBay100);
60.) i += (int) (fabs(1/z.squares() - 1/z2.squares())*1000*nBay100);
61.) Strands 1 [Bay Fact 1, Bay Fact 2] Chkr Brd
62.) Strands 2 [Bay Fact 1, Bay Fact 2] Chkr Brd
63.) Strands 3 [Bay Fact 1, Bay Fact 2]
64.) Strands 4 [Bay Fact 1, Bay Fact 2] Rings
65.) Strands 1 [Bay Fact 1, Bay Fact 2]
66.) Strands 2 [Bay Fact 1, Bay Fact 2]
67.) Strands 3 [Bay Fact 1, Bay Fact 2]
68.) Strands 4 [Bay Fact 1, Bay Fact 2] Rings
69.) Clouds
70.) i = atan(sqr(z(n)-sqr(z(n-1)))*256*Bay Fact 1



Color menu commands

The Color menu offers the following commands:

) Method 0 [None]
1.) if (dzx < dzx_save || dzy < dzy_save)
2.) if (z.real() > 0)
3.) temp = 1/atan(fabs(z.real()/z.imag()))*10*nBay100;
4.) temp = atan(fabs(z.real()/z.imag())) - atan(fabs(z.imag()/z.real()))*10*nBay100;
5.) if ((int)z.real() % 2 == 0)
6.) if (z.real()*z.imag() > c.real()*c.imag())
7.) if (z.squares() < dBailout)
8.) fabs(dStrands-dzx)*20000*nBay100;
9.) sin(1/fabs((dzx)/(dzy)))*500*nBay100;
10.) zsquares()*cos(fabs(dzx*dzx/dzy*dzy))*10000*nBay100;
11.) sin(function)*nBay100;
12.) cos(fabs(dzx*dzy/dzx_save*dzy_save)*10)*100*nBay100;
13.) (atan(1/fabs(c.real()/c.imag()))-atan(1/fabs(c.imag()/c.real())))*100*nBay100;
14.) atan(fabs(z.real()/z.imag()))*200*nBay100;
15.) temp = atan(fabs(c.real()/c.imag())) * atan(fabs(z.real()/z.imag()));
16.) temp = atan(fabs(z2.real()/z2.imag())) * atan(fabs(z.real()/z.imag()));
17.) temp = atan(fabs(z2.real()/z2.imag())) - atan(fabs(z.real()/z.imag()));
18.) temp = atan(fabs(z2.real()/z2.imag())) + atan(fabs(z.real()/z.imag()));
19.) Squares [Bay Fact 1]
20.) Circles [Bay Fact 1]
21.) Radial [Bay Fact 1]
22) Checkerboard Squares [Bay Fact 1, Bay Fact 2]



F-Dimension menu commands

The F-Dimension menu offers the following commands:

14.) None
FD Variate This option affects the following fractal dimension filters.
1.) FD_0 of x
2.) FD_0 of y
3.) FD_0x + FD_0y
4.) FD_0 Sum of Squares
5.) FD_0x * FD_0y
6.) FD of x
7) FD of y
8) FD_x + FD_y
9) FD Sum of Squares
10) FD_x * FD_y



Image menu commands

The Image menu offers the following commands:

Size Changes the size of the image.
Params Allows for changes to the fractal parameters.
Color parameters Allows for changing the image colors, brings up the Color Control dialog.
Cycle Automatically cycles the colors of the image.
Maintain aspect ration Toggles the mode for maintaining the aspect ratio of the fractal images.

View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Mandel Draws an image using the selected formula.
Zoom Re-draws the image selected in the Zoom Rectangle.
New If this option is selected, then new windows will be created in 

zooms and Julia set images.
Julia Draws a Julia set image based on the center point of the zoom 

rectangle. Only works when a Mandelbrot image is 
displayed.

             Stretch to Fit Increases or decreases the image size to fit into the window. 



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple 
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Size Desktop Re-sizes the current window to fit around an image.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help Topics Offers an index to topics on which you can get help.
About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in Flarium24. 

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

Use this command to open an existing document in a new window.    You can open multiple documents at once.    
Use the Window menu to switch among the multiple open documents 



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at once.    
Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the List Files 
of Type box. 

List Files of Type
Select the type of file you want to open:
Flarium24 will open files of type BMP.

Drives
Select the drive in which Flarium24 stores the file that you want to open. 

Directories
Select the directory in which Flarium24 stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    Flarium24 suggests that you save changes 
to your document before you close it.    If you close a document without saving, you lose all changes made since the 
last time you saved it.    Before closing an untitled document, Flarium24 displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a document for 
the first time, Flarium24 displays the Save As dialog box so you can name your document.    If you want to change 
the name and directory of an existing document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Flarium24 displays the Save As dialog box so you can 
name your document.    

To save a document with its existing name and directory, use the Save command.



Send command (File menu)

Use this command to send the active document through electronic mail.    This command presents a mail window 
with the active document attached to it.    You may then fill out the To: field, Subject: field, etc., and add text to the 
body of the message if you wish.    When you are finished you may click the "Send" button to send the message.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight characters 
and an extension of up to three characters.    Flarium24 adds the extension you specify in the Save File As Type 
box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application chooses via the OFN_ 
flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you closed.    
Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Flarium24 session.    You can also use the Close command on the application Control 
menu.    Flarium24 prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    Modify this help text 
accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the command changes, depending on
what the last action was.    The Undo command changes to Can't Undo on the menu if you cannot reverse your last 
action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    This 
command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no data 
currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is unavailable if 
the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands
in Flarium24, such as File Open.    A check mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar provides quick 
mouse access to many tools used in Flarium24,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your application offers. >>

Click To

Open a new document.

Open an existing document.    Flarium24 displays the Open dialog box, in which you can locate and open 
the desired file.

Save the active document or template with its current name.    If you have not named the document, 
Flarium24 displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.

Go to the first record in the current selection.

Go to the previous record in the current selection.

Go to the next record in the current selection.

Go to the last record in the current selection.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected 
menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when 
the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Flarium24 window.    To display or hide the status bar, use the Status 
Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus.  
This area similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing
them.    If after viewing the description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You can open multiple 
document windows to display different parts or views of a document at the same time.    If you change the contents 
in one window, all other windows containing the same document reflect those changes.    When you open a new 
window, it becomes the active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If there is an 
open document window at the bottom of the main window, then some or all of the icons may not be visible because 
they will be underneath this document window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or the keyboard arrows to 
move the splitter bars.    When you are finished, press the mouse button or enter to leave the splitter bars in their new
location.    Pressing escape keeps the splitter bars in their original location.    << In a single document interface 
application, this command will appear on the View menu. >>



1, 2, ... command (Window menu)

Flarium24 displays a list of currently open document windows at the bottom of the Window menu.    A check mark 
appears in front of the document name of the active window.    Choose a document from this list to make its window 
active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to step-by-step 
instructions for using Flarium24 and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Flarium24.



Context Help command 

Use the Context Help command to obtain help on some portion of Flarium24.    When you choose the Toolbar's 
Context Help button, the mouse pointer will change to an arrow and question mark.    Then click somewhere in the 
Flarium24 window, such as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the document.    You can use the mouse to scroll to other parts of the 
document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you 

want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow 
keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Flarium24 window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Flarium24 determines which window is next 
according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Flarium24 determines which window is 
previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document Control 
menu closes only one window at a time.    You can close all windows at once with the Close command on the File 
menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize 
command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an application
on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not affect 
applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect applications reduced 
to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to Can't Repeat 
if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Welcome to Flarium24, An Interactve Fractal Generation Program.

Flarium24 Topics
Overview
Features
Selecting an equation
Zooming in and out
Drawing Julia set fractals
Filters
Tips for using filters
Unique formula dialog

Menus
File menu
Draw menu
Attractor menu
Filter-1
Filter-2
Filter-3
Color menu
F-Dimension
Image menu
View menu
Window menu
Help menu

Formulae
Latoocarfian Formulae
2D Attractor Formulae
3D Attractor Formulae



Overview

Flarium24 is a program that generates fractal images which can also be used in backgrounds and textures for other 
images, artwork or photos. The minimum requirements to run Flarium24 is a system with the Windows 95 operating
system or Windows NT, 8 Mbytes of Ram, and a graphics display that is capable of at least 256 colors. High color or
true color is preferred. The program generates fractal images in a 24 bit true color mode and the images can be saved
in 24 bit bitmap files.

This program uses Win32 double precision floating point operations for all of the calculations.

The Flarium24 program can draw fractal images from a selected formula in three different methods. In this program,
these methods are refered to as the N-Set (or Newton) method, the M-Set (Mandelbrot) method and the F-Set 
(combination N-Set and M-Set).    The default drawing method is the N-Set method. To choose the other methods, 
select the F-Set or M-Set toggle toolbar buttons.

The formulae are separated into several categories. Formula 1 is the classic Mandelbrot formula z=z^2+c.    Formula 
2 contains the generalized Mandelbrot formula z=z^cn+c, which allows for the user to select the value of the 
complex number “cn”. The other categories are the Newton formula/ variations, the Paul Derbyshire Nova formula/ 
variations, Shigehiro Ushiki Phoenix curves, Sir William Rowan Hamilton’s Quaternions, several formulae 
contributed by Sharon Webb, strange attractor formulae based on algorithms by Julian C. Sprott, and several other 
formulae that were derived from books and resources too numerous to mention at this time.

A large portion of the Flarium24 program was based on another program, “Iterations.” The Iterations program was 
developed over a period of time with the help of Holger Jaenisch and James Handley.

The Flarium24 program has several filter options. The filters are used to enhance the image. The filters are done by 
first gathering data about the iteration, then applying the data to the final color value of the pixel.    Flters can be 
applied to every formula. Some of the most common used in the Flarium24 program are the atan, odd/even, delta 
slope, final x/y value positions, strands, and so on.    

The Flarium24 program also offers Color method options.    These color methods can be applied in conjunction with 
a filter to achieve ever more combinations of images. Some of the color methods involve adding a radial or circular 
gradient to the final image.



Features and capabilities:

· Approximately 160 equations for creating fractal images.    About 60 filters which can be applied to the 
equations.    The filters change the parameters within the iteration such as counting the number of change in the 
direction of the slope of the real and imaginary axis.    

· 24-bit bitmap file import and export.

· The image parameters can be saved and loaded to/from a parameters file.

· Multiple windows for creating and viewing multiple images simultaneously.

· All fractal images can be zoomed in or out by use of a zoom rectangle drawn with the mouse.    The rectangle 
has a 'X' cross in the middle.    This is used for selecting points (pixels) which are used for creating the Julia sets.

· A color control dialog is available for changing colors of the image.

Limitations:
· The bitmap images generated by the Flarium24 program is limited to about 268MBytes. A calculation of the file

size can be made by mutiplying the width times the height and then multiplying by 3. For example, the program
should be capable of generating an 8800 by 8800 image, since 8800 times 8800 times 3 equals 232,320,000, 
which is less than 268MBytes. This is, of course providing that you have enough free disk to support this size.



Selecting an equation

The first thing to do is select an equation. The equations are numbered starting with 1 and go through about 167.    
The equations are grouped in pop-up menu items under Draw.

Once an equation number is selected, the image will be automatically generated with the default fractal parameters.   
After the equation has been selected and generated, then several other options can be selected to change the 
appearance of the image such as changing the color, selecting a filter, zooming into the image or drawing a Julia 
fractal by selecting a point within the image.



Zooming in and out

Zooming tutorial: After the application has been started, select equation 1.) F(z) = z*z+c.    This is found under the 
Draw | Polynomials 1 | 1.) F(z) = z*z + c;    menu item.    Once this equation is selected, the image will 
automatically draw with the default parameters.    You will see the fractal image appear in the window.    To zoom 
into the window, draw a rectangle with the mouse by pointing to a location, pressing the left mouse button and 
dragging the pointer, then releasing the mouse button.    You will see a rectangle drawn on the image with an X cross
in the middle of it.    This rectangle can be moved around in the image by pointing inside the rectangle, pressing the 
left mouse button, and dragging the rectangle to a new location.    The right mouse button can be used to clear the 
rectangle, by selecting “Clear Rectangle” in the pop-up menu.    Once a region is within the rectangle, two toolbar 
buttons are highlighted.    These are the "Draw Julia Fractal" and the "Zoom into Rectangle" toolbar buttons.    To 
zoom into the region of the rectangle, click on the "Zoom into Rectangle" toolbar button.    The program will create 
a new window and generate a new image which was the region within the rectangle.    To zoom out of an image, the 
rectangle can be drawn outside of the image boundaries.    Also the fractal parameter coordinates can be adjusted 
using the fractal parameters dialog box.



Drawing Julia Set Fractals

The Julia set is name after the French soldier and mathematician Gaston Julia,    (1893-1978).

Julia set fractals are drawn by selecting a pixel on an image and then selecting the “Draw Julia” toolbar button.    
Julia sets can be drawn for most of the equations in the Flarium program.    As an example, to draw a Julia set, first 
select equation 1.) F(z) = z*z + c;    by selecting the Draw | Polynomials 1 | 1.) F(z) = z*z + c;    menu item.    Draw 
a zoom rectangle over the image.    Position the center of    the rectangle over an area near the fractal curve.    The 
center point is the center of the X within the rectangle.    Once a point is selected, the "Draw Julia Fractal" toolbar 
button will be highlighted.    Click on the    "Draw Julia Fractal" toolbar button and the Julia fractal will 
automatically be drawn in a new window.



Filters

Filters are found under the "Filters" main menu item.    Currently there are about 80 different filters.    A filter is used
to operate within the fractal equation to enhance the basic fractal image.    Each filter can operate on most of the 
equations.    Generally, only one filter can be used at a time.    For example, select equation 1.) F(z) = z*z + c by 
selecting the Draw | Polynomials 1 | 1.) F(z) = z*z + c;    menu item.    Then select Filter-1 | 15.) Standard 
Deviation.  The image will be automatically re-drawn with this filter applied. To remove the filter, select Filter-1 | 
0.) No Filter.    The image will be re-drawn without the filter applied to it.    When a new filter is selected, it will turn
off the previously selected filter.



Tips for using filters

Several of the filters are affected by parameters which are found in the Parameters Dialog Box.    Among these 
parameters that affect the filters are Bay Factor 1, Bay Fact 2, Strands, and Filter Factor (ff).

The following are some useful tips in using these parameters:

· All of the filters that have the word strands in them are affected by both the Strands parameter and the Bay 
Factor 1 parameter.    The default setting for the Strands parameter is .002.    Each strands filter is different, 
therefore the Strands parameter may need to be adjusted accordingly for each strands filter.    To increase the 
thickness of the strand, increase the Strands parameter from .002 up to about .07 or up to .2.    There should be a 
noticable increase in the thickness of the strands.    To make the strands thinner, decrease the Strands parameter 
from .002 to about .001 or .0005.    The Bay Factor 1 parameter also affects the degree of coloring of the strand. 
The default setting for the Bay Factor 1 parameter is 1.    To get more noticable coloring in the strands, increase 
the value of Bay Factor 1 from 1 to 1.5, or even as high as five for very radical coloring.    To decrease the 
amount of coloring of the strands, decrease Bay Factor 1 from 1 to about .5, or .1.    If you decrease the amount 
of coloring too much, the strands will look flat.

· The degree of coloring of the Fractal dimension filters can also be adjusted by using the Bay Factor 1 parameter
in the parameters dialog box.    To increase the degree of coloring of an image using the fractal dimension filter, 
increase the Bay Factor 1 parameter from 1 to 1.6 or as high as 4.5.    To decrease the degree of coloring, 
decrease the Bay Factor 1 parameter from 1 to about .5 or .1.

· Any filter menu item that has the word nBay100 is affected by the Bay Factor 1 parameter.    Any filter menu 
item that has the word nBay1000 in it is affected by the Bay Factor 2 parameter.

· The degree of coloring of the 2D and 3D attractors are can also be changed by adjusting the Bay Factor 1 
parameter.

· Any of the filters with the ff in the filter menu, are affected by the ff parameter.    The default is one.    If you 
increase the ff parameter value of 1 to 2, then there should be a noticable change in colors.    Also try changing 
this value to 3 or even up to 10.    Some of the filters that are affected by this are filters 1, 16, 17, and 18.



Newton Variations 1,

6) z=z-(z*z*z-1)/3*z*z; z=z*c;
25.) z=z-(z*z*z*z-z)/(4*z*z*z-z); z=z*c;
65) z = ((z-(((z^4)-z)/(4*(z^3))))^2)*c;
66.) z=((z-(((z^2)-1)/(2*z)))^2)*c;
67.) z = ((z-(((z^3)-1)/(3*(z^2))))^2)*c;
68.) z = ((z-(((z^4)-1)/(4*(z^4))))^2)*c;
69.) z = ((z-(((z^5)-1)/(5*(z^4))))^2)*c;
70.) z=z-(z*z*z*z*c-z+c)/(4*z*z*z*c);
71.) z=z-(z*z*z-z+c)/(3*z*z);
72.) z=z-(z*z*z*c-z*c-1)/(3*z*z*c);
73.) z=z-(z*z*z*c-z*z*c-1)/(3*z*z*c);
74.) z=z-(z*z*z*c-1)/(3*z*z*c);
75.) z=z-(z*z*z*c-z-1)/(3*z*z*c-z);
76.) z=z-(z*z*z*c-z*c-1)/(3*z*z*c-z);
77.) z=z-(z*z*z*c-z*z-1)/(3*z*z*c-3*z*z-3*z);
78.) z=z-(z*z*z*c-z*z*c-1)/(3*z*z*c-z*c-z);
80.) z=((z*z*z*z-1)/(1-(3*z*z*z)))*c;



Newton Variations 2

94.) z=((z*z*z-z-1)/(z*z*z-1)-z)*c;
95.) z=((z*z*z*z-z*z-1)/(4*z*z*z-1)-z)*c;
96.) z1=z*z; z=(z-(z*z1-1)/(3*z1-z.abs()-1))*c;
97.) z1=z*z; z=(z-(z*z1-1)/(3*z1-z-1))*c;
98.) z1=z*z*z; z=((z*z1-z-1)/(4*z1-z-1)-z)*c;
99.) z1=z*z; z=((z*z1-z-1)/(3*z1-1)-z)*c;
100.) z1=z*z; z=(z-(z*z1-1)/(4*z1-z-1))*c;
101.) z1=z*z; z=(z-(z*z1-1)/(3*z1-z))*c;
102.) z1=z*z*z; z=(z-(z*z1-1)/(4*z1-z))*c;
103.) z1=z*z*z; z=(z-(z*z1-1)/(3*z1-z))*c;
104.) z1=z*z*z; z=(z-(z*z1-z-1)/(3*z1-z))*c;
105.) z=c*(z-(z*z*z-z)/(3*z*z-1));
106.) z1=z*z*z; z=((1-z-z1*z)/(z-(4*z1))-z)*c;
107.) z1=z*z*z; z=((z-z1*z)/(z-(3*z1))-z)*c;
108.) z1=z*z*z; z=((z-z1)/(z-(3*z1))-z)*c;
109.) z1=z*z; z=((z1*z-1)/(2*z1-1)-z)*c;
110.) z1=z*z; z=((z*z1-z-1)/(3*z*z1-1)-z)*c;
117.) z = z-(z*z*z-z*c-1)/(3*z*z+c-1);



Sharon Webb

8.) z = z*z*z*z+1/c; [Sharon Star]
50) z = z*z*z*z+1/c; // Sharon's Star M-Set
9) z = (z*z/2+c)*(z*z/2+c); [Sharon's Space Probe]
51) z = (z*z/2+c)*(z*z/2+c);    // Space Probe M-Set
10) z = z*z*z*z+((c/2)^2)+c; [Sharon08]
52) z = z*z*z*z+t+c;    // Sharon08 M-Set
11) z = z*z*z*z+(z^(z+cn))+c;
12) z = (z+z*z/2)+c;
53) z = (z+z*z/2)+c; // M-Set
13) z=(z*z*z*z-z2*z2*z2*z2+c)^2;
21) z=(1/z*z-c)*(z*z*z*z+c); [Sharon03]
34) z1= z*(z*z).csin()/2; z=z1*z1 + c; [Sharon14]
46) z1= z*(z*z).csin()/2; z=z1*z1 + c; [Sharon14 N-Method]
111) z1= z*(z*z).csin()/2; z=z1*z1 + c; [Alden's Ray Method]
63) z1=z; z=z*z*z*z+z2/2+c; z2=z1; [Webb]
90) z = (z*(z*z).csin()/2).csin()+c; [Sharon15]
91) z = (z*(z+z).ccos()/2); z = z*z+c; [Sharon16]
92) z = (z*(z+z).csin()/2); z = z*z+c; [Sharon17]
93) z = (z*(z+z*z).csin()/2); z = z*z+c; [Sharon18]
118) z = (z*z*z*z*z).csin() + c; // Sharon19
119) z = (z+(z*z)/.192).csin() + c; // Sharon's Butterfly (20)
125) z = z+z*z*z/4 + c; // Sharon21



Polynomials 1

1) z = z*z+c;
2) z = (z^cn)+c; [Generalized Mandelbrot]
3) z = z*z*z-aa3*z+b; [CBAP]
4) z = z*z+c; real=imag, imag=real;
5) z = z*z*sin(z.real()) + c*z*cos(z.imag()) + c;
7) z = (z*z+c)^(cn+c);
22) z2=cmplx(.5,0); z=z*z-z2*z2+c;
23) z=z*z*z*z+z2+c;
24) z=z*z*z*z+2*cn*z2*c;
26) z = ((z^3)/((z+.1)^2))+c;
27) z=z*z*(cn+z)/(cn+z+c)+c;
61) z=z*z*z*z+(c+(c/pi));
62) z=z*z*(1+z)/(1+z+c)+c;
86) z=zcsin()+z*z*z*z+c; c=t+z1-z;
87) z=z*z*z-t*t*t+c;
88) z=z*z*z*z-t*t*t*t+c;
89) z = z*z*z*z/t+c;



Polynomials 2

31) z = z*z*z-aa3*z+b;
35) z=c*(z.csin());
36) z=(c*z).csin();
37) z=(z*z*z-1)/(3*z*z); z = c*(z.csin() + z.ccos());
38) z = z*z+c; z.set_real(z.real()*z.real()); [Variation real]
39) z = z*z + c; c = c/2 + z; [Spider]
40) z1 = z*z*z*z; z = c*z1/4*z1 + z;
41) z = c*(z*z*z*z).csin();
42) z = z-((z*z*z)+(t-1)*z-t)/(3*(z*z)+c-1);
43) z = z*z*z*z + (z*c).csin() + c;
44) z=(z*z*z*z-z)/(4*z*z*z); z=c*z.csin();
45) z=(z*z*z*z-1)/(4*z*z*z); z=c*z.csin();
49) z=(z*z*z*z-z)/((4*z*z*z)-z); z=c*z.csin();
54) z = z*z*c+c;    // M-Set
55) z = (z*z).csin()*z*z*c+c;    // M-Set
56) z = (z*z+c)/(z*z-c); // M-Set
112) z=z*z*c+z*c;
113) z=z*z*z*c+z*c;
114) z=z*z*z*c*c+z*c;
115) z=z*z*z*z*c*c+z*c;
116) z=z*z*z*z*z*c+z*c;



Derbyshire / Newton

14) z = z - (z*z*z-1)/(3*z*z) + c; [3rd Order Nova]
15) z = z - (z*z*z*z-1)/(4*z*z*z) + c; [4th Order Nova]
16) z = z - (z*z*z*z*z-1)/(5*z*z*z*z) + c; [5th Order Nova]
17) z = ((cn-1)*(z^cn)+cr)/(cn*(z^(cn-1))) + z1; [Generalized Newton]
28) z=z - (z*z*z-1)/(3*z*z)+c; [Nova-Mandelbrot-MultiFract]
29) c = (z*z*z-1)/(3*z*z); z -= (z*z*z-1)/(3*z*z)*c;
30) z -= (z*z*z-1)/(3*z*z)*c;
32) 3rd Order Nova in a M-Set
33) Newton formulae in the Mandelbrot method
47) z=z-(z*z*z*z-z)/((4*z*z*z)-1)+c; [Nova Variation]
48) z=z-(z*z*z*z-z)/((4*z*z*z)-z)+c; [Nova Variation]
57) z=z-(z*z1-z)/((5*z1)-z)+c; // 5th Order Nova Variation
58) z=z-(z*z1-z)/((3*z1)-z)+c; // 3rd Order Nova Variation
59) z=z-(z*z1-z)/((3*z1)-1)+c; // 3rd Order Nova Variation
60) z=z-(z*z1-z)/((5*z1)-1)+c; // 5th Order Nova Variation



Phoenix

18) z = z*z+c.imag()+c.real()*z2; [2nd Order Phoenix]
19) z = z*z*z+c.imag()+c.real()*z2; [3rd Order Phoenix]
20) z = z*z*z*z+c.imag()+c.real()*z2; [4th Order Phoenix]
64) z1=z; z=z*z*z*z+c.real()*z2/2+c.imag()*z2/2+c; z2=z1;



Geometric

79) z=z*c;
81) Squares
82) Circles
83) Radial
84) Spiral
0.) Color Test Pattern
85) Color Test Pattern 2



Quaternions

133) A0 and A3 Constant
134) A0 and A1 Constant
135) A0 and A2 Constant
136) A0 and A3 Constant
137) A1 and A2 Constant
138) A2 and A3 Constant

Quaternion Parameters



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx values from 
the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For example, 
AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




